
 

  
 

 

  

 

 

 

 

 

 

 

 

  

 

 

 

Word 2007 
Best Practices for Authoring Structured and Accessible 
Documents 
 

 

 

 

 

 

IT Training & Development 

(818) 677-1700 

training@csun.edu 

http://www.csun.edu/it/training  

 

 

  

 
  Information Technology 
 
 
   MS Word 2007 
   Users Guide 
 

mailto:training@csun.edu�


 

  
 

 

  

  



 

Word 2007- Best Practices for Authoring Structured & Accessible Documents  Page i 
 

TABLE OF CONTENTS 

Word 2007 ............................................................................................................................. 1 

Introduction ............................................................................................................................ 1 

Create Structured Documents ................................................................................................ 1 

Best Practice in Word ............................................................................................................. 1 

Using Styles Formatting – Why it is so important.................................................................... 2 

Benefits of Using Styles:..................................................................................................... 2 

Header Sizes and Tips: ...................................................................................................... 3 

Using the Quick Styles Gallery: .......................................................................................... 3 

Inserting Headers or Styles from the Styles Group: ............................................................ 6 

Inserting Styles while working in a document ........................................................... 6 

Inserting Styles if document is already completed .................................................... 6 

Using Word’s Preformatted Style Sets: ............................................................................... 7 

Choose a Quick Style set to apply to a document ..................................................... 7 

Changing/Modifying the Styles: .......................................................................................... 8 

Create New Styles: ............................................................................................................. 9 

Creating & Using Lists ...........................................................................................................10 

Best practices for using lists in word ........................................................................10 

Creating the Correct Type of List: ......................................................................................10 

Unordered vs. Ordered Lists....................................................................................10 

Create lists as you type ...........................................................................................10 

Finish the list / Stop Bullets or Numbers Appearing ...........................................................11 

Format a List .....................................................................................................................12 

Using Images In Your Document ...........................................................................................12 

Inserting Images/Pictures ..................................................................................................12 

Image Labeling - ALT Text (tags) ......................................................................................13 

Using Charts and Data Tables: .............................................................................................14 

Creating Charts: ................................................................................................................14 

Inserting Tables: ................................................................................................................16 

Word Final Touches ..............................................................................................................18 

Enter Additional Document Properties Information: ...........................................................18 



  
 

Word 2007 – Best Practices for Authoring Structured & Accessible Documents Page ii 
 

Saving Your Document:.....................................................................................................19 

Saving Your Word Document as a PDF ............................................................................19 

If you have Adobe Acrobat Professional .........................................................................20 

If you DO NOT have Adobe Acrobat Professional ..........................................................24 

Saving Your Word Document as HTML .............................................................................25 

Quick Tips to Accessible Word Processing Documents.........................................................26 

Other Resources or Training .................................................................................................26 

 

 

 



 

Word 2007 – Best Practices for Authoring Structured & Accessible Documents  Page 1 of 31 

INTRODUCTION 

Microsoft Word is currently the most common word processor on the market. Word files can be 
used to create other file formats, such as PDF and HTML. MS Word 2007 makes it easy to 
create a structured document that can be converted simply to these other file formats.  

CREATE STRUCTURED DOCUMENTS  

Microsoft Word contains features which provide structure to your documents.  This structure 
allows many different types of individuals to navigate and use a document.  By following Best 
Practices when using Word, accessibility can be achieved while creating or updating a 
document.  In order to ensure that Word documents are ultimately accessible, well structured 
and created in a way that saves you time, you will want to utilize the formatting and layout 
options within Microsoft Word Structural markup makes it easier for individuals to navigate the 
document and will be discernable to those using assistive technology 

BEST PRACTICE IN WORD 

Best practices refer to a collection of how to do and what to avoid when authoring Microsoft 
Office documents and the ability to convert the document.  

 Following best practices will help you: 
o Utilize the software efficiently 
o Use a simple conversion process  
o Help to create navigable, structured documents 

 If in the original creation of the document design, structure was not done correctly, the final 
product will have missing information and display content incorrectly.   

Get in the habit of always following best practices. Create tables, charts and layouts  using the 
appropriate features in Word and you will actually save time while preparing a flexible and 
quality document.  The more structure that is designed in to the document, the more accessible 
it will be.   Universal Design is the goal when creating documents. This simply means that all 
people can perceive, understand, navigate, and interact with the document. 

Advantages of true structure in Word documents: The file can easily be exported to a 
PDF or HTML document retaining necessary structure for posting on the web or sending in 
email. Secondly, when exported to HTML, structure will also be retained and with a few code 
tweaks your word document will be accessible. In both cases, the added structure increases the 
readability of the document for people using assistive technology. 
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USING STYLES FORMATTING – WHY IT IS SO IMPORTANT 

In Word, the correct way to provide structure is to use Word styles.  A style is a tool that helps 
you format a document. They are specially crafted packages of formatting that apply many 
attributes at once instead of each attribute individually. 

Styles help you do simple and complex formatting and do it with minimal fuss.  Many people use 
basic formatting, for example, when creating a heading, they simply change the font, enlarge 
the font size, make it bold, etc.  But styles differ from basic formatting and have many more 
benefits as well as a lot less keystrokes.   Styles also transfer over when converting a Word 
document into a PDF. 

Using Styles is an important element in giving your document true structure. Word 2007 
has dedicated half of the Home tab ribbon to styles. (figure 1 below) 

Figure 1 – Home Tab, Styles Group 

 
 

 Use the Quick Styles gallery to format all the text in the document. 
 Use the Heading 1, Heading 2, and Heading 3 headings to mark-up the text and 

add structure to the document.  These should be used in the same way as titles and 
subtitles in the document.  

 Use the Normal style option for the body of the text.  
 Formatting may need to be cleared on any document whose formatting is in 

question. (i.e. documents that have been inherited or were not formatted using the 
above methods). 

 Avoid using text boxes to format text layouts. 
 

Benefits of Using Styles: 

Headers are used to separate sections of the document. The benefit to using headers in 
the quick styles gallery over just making a font large and bold is that Headers will 
automatically create an outline of the document, or an index of the sections. The Header 
functions in the quick styles gallery to define document sections. This document is a good 
example of the use of Header styles to define outlines or sections of your document.  An 
additional benefit with the use of Headers is that formatting changes can be made quickly 
and easily throughout the document. 
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Header Sizes and Tips: 

Since Headers create an outline or index of the document, they should be used in an order to 
represent the flow of the document. Heading 1 (or H1) is generally the largest header. Heading 
2 (or H2) would be smaller than H1 but larger than Heading 3 (H3).  

An example of how headers can be used to order information can be seen on the previous page 
of this document. The heading, "Using Styles Formatting – Why it is so important," is a H2 style. 
The "Benefits of Using Styles"  is a H3 style. This is a continued pattern use of styles. By 
creating this structure, you can create a table of contents from your document with just one 
click. See the table of contents in this document to see how each header style reflects in the 
table of contents. 

Tips for where to use a Heading 1, Heading 2, Heading 3 size include: 

 Title: Titles the document. There should be only one Title in your document 

 Heading1: Main heading in the document  

 Heading 2: Subheadings of Heading 1  

 Heading 3: Subheadings of Heading 2  

 Do not use header styles for emphasis of a word or phrase within a body of text 

there are other Styles available to do that.  

Using the Quick Styles Gallery: 

The Quick Styles Gallery can be expanded by selecting the down arrow to the right of this 
field to show some of the other quick styles (see figure 2a & 2b) or the gallery can be 
expanded by selecting the launcher, to show the styles task pane to see all styles available. 
(see figure 2c) 

Figure 2a –Expand Styles Options 
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Figure 2b – Home Tab, Quick Styles Gallery expanded 

 

Figure 2c – Home Tab, Styles Launcher selected to view the styles task pane. 

 

There are different style types in Word. Knowing about them will help you understand what 
you're looking at in the task pane, what your options are for creating new styles, and what 
impact a style will have on the text in your document. There are three style types:  

 Paragraph styles 

 Character styles 

 Linked styles 
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Paragraph styles  

 Includes not just the font, font type and size but also formatting for a whole paragraph's 
text positioning and spacing.  

 A paragraph style can be applied to one or more paragraphs.  

 In the styles task pane it has a paragraph icon next to it. 
 A paragraph style's formatting will be applied to all the text within the end paragraph 

mark of where your pointer is positioned.  

Note:   The Normal paragraph style you see highlighted above is the default style, which 
means it applies to all paragraphs in the document, not just a single paragraph.  

Character styles  

 Are applied at the character level — to blocks of words and letters — rather than the 
paragraph level. An example would be an "emphasis" style that applies, say, an italic 
type.  

 Can apply character styles along with the paragraph style. For example, if the paragraph 
style is Normal, using Calibri as the font, and you applied the "emphasis" style to a word, 
you'd still have Calibri as the font, but it would also have italic and underline formatting. 
This emphasis would apply only to the word where you’ve placed your cursor.  

 Character styles have the character icon next to them in the Styles task pane.  

Linked styles  

 Can behave as either a character style or a paragraph style, depending on what you 
select. If you click in a paragraph or select a paragraph and then apply a linked style, the 
style is applied as a paragraph style. However, if you select a word or phrase in the 
paragraph and apply a linked style, the style is applied as a character style, with no 
effect on the paragraph as a whole.  

 Word includes many built-in linked styles, which have the linked-styles icon next to 
them in the Styles task pane.  

 

When you point to a style in the Style task pane, a ScreenTip lists all the details of the style. As 
you can see in the picture below, all the formatting included in the Normal style is spelled out, so 
you can see all of its attributes. 
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Figure 2d – Styles task pane showing screen tip list of the details of the style 

 

About the Normal style: When you create a new document in Word, Normal is the default 
paragraph style in the document. It is the style for the document's body text, but it's also the 
basis for many other styles. 

Inserting Headers or Styles from the Styles Group: 

Inserting Styles while working in a document 

While working on a document, Headers can be inserted as information is entered. 

To insert a header or any other style from the style group: 

1. Place cursor at the spot where the Header or style will be inserted. 
2. From the Home Tab, in the Styles Group, click the style to be used. 
3. Type the text. 
4. The style is applied as you type.   
5. If it is a Header you area creating, the style will return to the body text style when 

you strike Enter to continue with the document. 
6. To change the style as you proceed through your document, simply click on the 

new style from the style group before you begin to type the next section.  

Inserting Styles if document is already completed 

If the document is already completed and headers or styles need to be inserted: 

Highlight the text that will be converted  

1. Select a style from the style bar.  
2. When you click the style, it will change the highlighted text. 
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Using Word’s Preformatted Style Sets: 

In MS Word 2007 you can choose a set of styles that are designed to work together. The style 

colors and formats in a single style set are created to work together for an attractive and 

readable document. 

Simply choose the Quick Style set from the styles gallery that is appropriate for the document 

that you are creating.  

Choose a Quick Style set to apply to a document 

When beginning work on a new document, choose from several predesigned Quick Style sets, 

such as Formal. Each Quick Style set may include styles for several heading levels, body text, 

quotes, and titles that are designed to work together in a single document. 

1. On the Home tab, in the Styles group, select Change Styles, and then point to Style 
Set.  See figure 3. 

2. Select a Quick Style set, such as Formal.  

NOTE: You do not have to change the style to see how it will look. Instead, point to each 
Style Set to see how it will appear in your document. 

 Figure 3 – Quick Style Options 
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Changing/Modifying the Styles: 

Formatting of each Style can be changed or modified to meet your needs. You may want a 
different font or font color for one of the existing heading styles.   

To modify a selected style for the document:   

1. Right click on the style in the style group 
2. Select Modify 
3. The Modify Styles dialog box appears. See figure 4. 
4. Under the Formatting field, the Font type, size, emphasis and color can be changed. 
5. Select the Format button, located at the bottom left, to modify other formatting such as 

border, paragraph, tab. Etc. 
6. Right click once more on the style and select the Update to Match Selection 

command.  Everything that has this style updates to reflect the change. 

Figure 4 – Modify Style dialog box 

 

Along with making the formatting changes you want, you have many other choices, including 
these:  

1. Rename the style (except for built-in styles). Give it a name that you'll recognize at a 
glance.  

2. Change the style that this style is based on.  
3. Update the template to reflect the modified style. Doing so will allow you to see and 

use the modified style in your next document created. 
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Create New Styles: 

If you want to alter a style, but you don't want to permanently alter original styles in your 
document's template, create a completely new style.  

Here's one way to do this: If you're creating a new heading style, select text with the heading 
style you want to alter, and make the formatting changes to it, such as a bigger font size, 
different style, and different color. Then:  

 Open the expanded Quick Styles gallery. 

 Select Save selection as a New Quick Style 

 Rename the style in the Create New Style from Formatting dialog box. 

 
 

Tip :  Another way to create a new style is to click in the document, in the actual style you want 
to build the new style on. Select the down button next to the Quick Gallery to display the 
expanded gallery and select Save Selection as a New Quick Style.  
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CREATING & USING LISTS 

Best practices for using lists in word 

Information is usually placed into lists to emphasize, group or order information. Knowing why 
you are placing information in a list layout will allow you to select the correct type of list to use.  

Best practices for lists are to create the list by using the Bullets and Numbering feature available 
on the Home tab in the Paragraph group. This will create the necessary structure in your 
document needed when you want to convert the document to another file type. An additional 
benefit to using this feature is that adaptive technology users recognize the information as a list. 
Do not use special characters or fonts (such as Wingdings) or just indenting a line to create a 
list. This does not create the structure in the document and will not convey as a list by adaptive 
technology users. 

Creating the Correct Type of List: 

Unordered vs. Ordered Lists  

Unordered lists – also referred to as bulleted items. This type of list would include one or more 
list elements. 

Ordered Lists - used when a sequence of items to be followed in a particular order. Ordered 
lists are used with directions, such as the steps in a recipe. This type of list would include two or 
more list elements.  

Create lists as you type 

To create an Unordered or Ordered List: 

1. From the Home tab in the Paragraph group on the ribbon, click the appropriate 
list command button. (See Figure 5) 

2. Enter each item for the list using the enter key at the end of each item.  

Note: The small down arrow next to the command button will offer an expanded list library of 
options. 

Figure 5 – Modify Style dialog box 
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Sample Unordered List 

• Uses bullets not number sequencing 
• Bullets can be modified by choosing the down arrow next to the command button. 

Sample Ordered List 

1. Uses number sequencing 
2. Use when presenting items in an order 

 

NEW IN WORD 2007 is the ability to automatically create lists as you type by using a 
symbol along with a command as you type . 

 If you need a bulleted list, just type an asterisk (*) followed by a space. The asterisk 
turns into a bullet and your list is started. When you've finished typing the first item in 
your list, press ENTER and a new bullet will appear on the next line.  

 To automatically create numbered lists, type the number one and a period (1.), followed 
by a space. 

 To automatically create a lettered list, type the letter a and a period (a.), followed by a 
space, to start a lettered list. 

Finish the list / Stop Bullets or Numbers Appearing 

To Stop a list: press ENTER twice. Every time you press ENTER at the end of the list you get 
a new bullet or number, but if you press ENTER again, the last bullet or number disappears and 
you're ready to start a new paragraph on a new line. 

To type text under a bullet that’s indented: if you're in the middle of a list and you want to 
type some text under your bullet that's indented at the same level as the text above, use the 
BACKSPACE key. This removes the bullet but keeps the text indent identical. 

 If you want the new text aligned under the bullet itself rather than in line with the text above, 
press BACKSPACE again.  

Finally to get out of the list indentations completely, press BACKSPACE again. 

 

Tip:    If you want to sort a list after creating it, for example, into alphabetical order, you can use 

the Sort button in the Paragraph group on the Home tab of the Ribbon. Keep in mind that 
when you sort a numbered list, only the list items are sorted, not the numbers (so number 1 will 
still appear first, and so on).  
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Format a List 

 Lists can format the bullets or numbers separately from the text in the list items. For example, 
you could have standard black text with bold red numbers.  

To do this: 

1. Select or Click one of the bullets or numbers to select just them, not the text in the list 
items. See figure below. 

 

2. Format them the way you would any other text by using the commands on the Ribbon.  
3. Click away from the list to see the final reformatted list. 

This modification can be saved as a style and can be easily accessed from the Style Task 
Pane. 

 

For more information on lists and list types and functions go to 
http://office.microsoft.com/training/Training.aspx?AssetID=RC102161651033&CTT=6&Origin=R
C102161651033 for an online tutorial of Bullets, numbers and lists. 

USING IMAGES IN YOUR DOCUMENT  

Images are used in documents for reference, emphasis, explanation, or aesthetics. It is best 

practice is to use images that are representative of the content of the document. 

Inserting Images/Pictures 

Placement consideration of an image in your document is important. Place images so they 

will make sense. 

 It is best practice to left align an image. This will be helpful when converting the 

document to html. Avoid placing images in tables.  

http://office.microsoft.com/training/Training.aspx?AssetID=RC102161651033&CTT=6&Origin=RC102161651033�
http://office.microsoft.com/training/Training.aspx?AssetID=RC102161651033&CTT=6&Origin=RC102161651033�
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Figure 6 - example of a left aligned image 

 

Image Labeling - ALT Text (tags)  

It is important that all images have a text description attached to it.  This allows for a description 
of an image when people do not have graphics enabled on their computers.  This description is 
called an Alt Text in Word. 

The text description should support the context of the document and/or conveys information to 
the user.  

 Provide a short description of the image that would briefly describe what the image is 
representing. If the example image was part of a technique for typing with one finger, a 
short description might read "One-finger typing technique with index finger" while 
the long description would include more details such as "The one-finger typing 
technique uses the index finger to strike keys while the remaining fingers and thumb are 
extended away from the keyboard." 

To enter a text description for an image: 

1. Right-click on the image 
2. The short cut menu appears  (see figure 7) 
3. Select  “Size” from the menu. 
4. The Size dialog box appears (see figure 8) 
5. Select the Alt Text tab 
6. In the Alternative Text: field, enter the image description. 
7. Select the Close button. 
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8. Use discretion in applying ALT tags.  ALT tags need to be descriptive and convey the 
meaning behind why the artwork or illustration has been included in the text.   They do 
not need to be lengthy.   

Figure 7 - Shortcut menu, Size option Figure 8 – Size dialog box, Alt Text tab 

               

USING CHARTS AND DATA TABLES: 

Charts and Data Tables are visual ways of representing a group of data. A best practice for 
charts and data tables in Microsoft Word is to create the items within the document. 
 

• Charts – Charts are recognized as images when converted to html.  A Chart will need 
to have information that describes the chart just like other images in your document.  

• Tables - A table is a row and column matrix of cells that can contain text, images and 
other objects. While the main purpose of tables is to present data in a grid format, they 
can also be used to control the layout of content on a page.  

Creating Charts: 

To create a new chart: 

1. From the Insert tab, select Chart  
2. The Insert Chart dialog box appears (figure 9) 
3. From the Left hand menu select the chart option 
4. From the Right hand display, select the chart type. 
5. Select OK 
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Figure 9 – Inserting a new chart 

 

6. The Datasheet View in Excel appears to enter data or identify the data to chart. Add 

values by selecting a cell and typing in the value.  

• Remember to be sure that the data has labels for the rows and columns. This is 
important because it equates to items for the Axis and Legends of the chart.   

• You can also paste information from another source into a cell.  
• Information in the Datasheet can be formatted for font, size, color, etc. from the 

Formatting Toolbar (Figure 10) 
 

Figure 10 – Identifying the Data set for your chart

 

7. Highlight the range of data in the Datasheet 
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8. Click back to your word document.  The new chart has been created with the selected 
range of data. (Figure 11) 
 
Figure 11 – New Chart created from selected data. 

 

NOTE:  Be sure to place a description of the chart and the data represented BEFORE 

inserting the chart in your document. 

Inserting Tables: 

Good Accessibility Practices for Tables 

• Keep tables simple with minimal nesting.  
• Avoid complex nested tables with multiple split and merged cells.  
• Avoid splitting or merging cells after data has been entered, as this can confuse the reading 

order of the cells.  
• Use percentage rather than pixels to set table and cell size. This will allow the table to resize 

gracefully.  
• Keep heading labels short and descriptive. Use comments if they need longer explanations.  
• Add descriptions before the table to provide information about the table.  
• The reading order of tables is linear starting from the top left cell to the bottom right cell. The 

contents of each cell, including nested cells, are read before moving to the next cell. 

To create a table: 

1. From the Insert tab click Table (See figure 12)  
2. Drag your mouse over the squares to designate the number of columns and rows to 

insert.  
3. Left Click the mouse once designated. 
4. The table appears on the word document. 
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Figure 12 – Inserting a table 

 

5. A new tab named “Design” has also appeared on the Ribbon. (See figure 13) This is an 
on demand tab and will appear any time the table is selected and active. Use the 
command elements on this tab to quickly format your table. 

Figure 13 – “On Demand” Design Tab to format table 
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WORD FINAL TOUCHES 

Enter Additional Document Properties Information: 

Microsoft Word allows you the opportunity to insert summary information about the document 
such as author name, date created, and comments. This is entered in the PROPERTIES box. 

To access the Properties box: 

1. From the Microsoft Office Button, Select Prepare (See figure 14) 
2. From the submenu select Properties. 

Figure 14 – Microsoft Office Button Options, select Prepare then Properties 

 

3. The Document Properties box is displayed just below the Ribbon. (see Figure 15) 

Figure 15 – Document Properties box 

 

4. Fill in the appropriate fields such as, Author, Title, Subject 
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Saving Your Document: 

Be sure to save your original work as a .doc or .docx file. 

To save a document: 

1. From the Microsoft Office Button, Select Save As (See Figure 16) 
2. Click on either 1) Word Document – to save as a Word 2007 .docx file OR 2) Word 97-

2003 Document – to save as a lower version .doc file.      

Figure 16 – Microsoft Office Button menu – Save As 

 

3. The “Save As” dialog box appears 

4. Be sure to fill in “Save In” and “File Name” fields. 

5. Select OK 

Saving Your Word Document as a PDF  

Saving a document as a PDF is a great way to save the content and formatting of a document 
so that when others want to print the document it maintains its integrity.  If you will be posting 
the PDF document to a website it is recommended that you state that the PDF document link is 
a “printer friendly” version.   
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If you have Adobe Acrobat Professional 

Enable Tagging in Microsoft Word 2007 

Note: The computer being used must have Adobe Acrobat 7.0 or higher. By enabling tags, 
your Styles will be carried with the PDF conversion. (figure 17)  

1. Select the Acrobat Tab 

2. Select Preferences 
 
Figure 17 – Acrobat tab, followed by the <Preferences> option 

 

3. Select: Enable Accessibility and Reflow with tagged Adobe PDF 

Figure 18 – Acrobat PDF Maker Window 
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Saving a Microsoft word doc as a pdf 

1. From the Microsoft Office Button, Select Save As (See Figure 19) 

2. Select Adobe PDF from the right hand menu 
 

Figure 19 – Microsoft Office Button, Save As > Adobe PDF 

 
 

3. The Acrobat PDF Maker warning window will appear (See figure 20) 
 

Figure 20 – Acrobat PDF Maker warning window 

 
 

4. Select the “Yes” button 
5. The “Save Adobe PDF File As” window will appear. (see figure 21) 
 

  



 

Word 2007 – Best Practices for Authoring Structured & Accessible Documents Page 22 
 

Figure 21 – Save Adobe PDF File As window 
 

 
 

 

6. In the “Save in” and “File name” fields, fill in appropriate information. 

7. Select the “Save” button 

8. An Adobe Processing window will appear showing that it is converting the document.  

(See figure 22) 

 
 
Figure 22 – Adobe Processing Window 

 
 
 

9. Once processed, the Word document will open in Adobe Acrobat as a PDF document. 

(See figure 23) 
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Figure 23 – Document displays in Adobe Acrobat Professional as a PDF 

 
 
 

10.  To perform a quick Accessibility check of your PDF document, click on the Documents 
menu and select Accessibility Quick Check.  (see figure 24) 

 
 
 

Figure 24 – Perform an Accessibility Quick check on your PDF Document 
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If you DO NOT have Adobe Acrobat Professional 

It is not recommended that these PDF documents be used as an accessible document.  

1. For Office 2007 users –  
a. Download the FREE plug-in from Microsoft.com that will allow you to export and 

save to the PDF format.  
b. http://www.microsoft.com/downloads/details.aspx?FamilyId=F1FC413C-6D89-

4F15-991B-63B07BA5F2E5&displaylang=en    
c. You can also us Internet Explorer and Google “Microsoft Save as PDF” and the 

link should come up as well. 
d. Once at the Microsoft Download Center click the Download button and follow the 

instructions. 
2. For Office 2003 users – There is no plug-in from Microsoft.  You must buy Adobe 

Acrobat. 

3. Once Plug-in is downloaded and installed, Select the Microsoft Office Button in your 

Word document, Select Save As (See Figure 25) 

4. Select PDF or XPS  from the right hand menu 

 

Figure 25 – Microsoft Office Button, Save As > PDF or XPS 

 
 

 
5. Once processed, the Word document will open in Adobe Acrobat Reader as a PDF 

document.  
6. To perform a quick Accessibility check of your PDF document, select the Documents 

menu and select Accessibility Quick Check.  (see figure25 above) 
 

http://www.microsoft.com/downloads/details.aspx?FamilyId=F1FC413C-6D89-4F15-991B-63B07BA5F2E5&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?FamilyId=F1FC413C-6D89-4F15-991B-63B07BA5F2E5&displaylang=en�
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Saving Your Word Document as HTML 

To save your Word 2007 document as an HTML file to publish to a website: 
 

1. From the Microsoft Office Button, Select Save As      
2. From the Submenu at right, Select “Other Formats” 

3. The Save As dialog window appears. (See figure 26) 

4. From the “Save as type:” field, use the down arrow at the end of the field to show and 

select “Web Page (*.htm; *.html)” option. 

5. Be sure to also Name and save the document to the appropriate file. 

6. Select 

7.  the Closed button. 

Figure 26 – Save As Dialog Window 
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QUICK TIPS TO ACCESSIBLE WORD PROCESSING DOCUMENTS  

When done correctly, the document ensures correct reading-order and allows it to reflow to fit 
the display when the magnification or display size is changed.  

• Place content in logical reading order. This is fundamental to creating accessible 
documents.  

• Do not use TAB, Spacebar and Enter keys to format for tables, columns, lists etc.  
• Use the application's built-in features to encode semantic structure (headings, paragraphs, 

lists, sections, headers/footers, tables, columns, forms etc.).  
• Define and use styles to format structural elements like headings, paragraphs etc. to control 

typography and layout.  
• Use standard fonts. Do not use fonts that do not map to Unicode, for example Wingdings.  
• Avoid complex layout, sidebars and other ornamentation as they make it difficult to maintain 

a logical reading order.  
• Avoid placing content in drawing-canvases or text-boxes as these are floating objects and 

flow to the bottom of a page's reading-order.  
• Group multiple graphic elements (created by drawing tools, charts etc) into one image.  
• Provide alternative text descriptors for all non-textual elements (graphs, images, illustration, 

pictures, multimedia, etc) that provide essential information.  
• Ensure that all navigation and interactivity can be performed using the keyboard. 

OTHER RESOURCES OR TRAINING 

1. Microsoft Online – Create an accessible Office document 
http://office.microsoft.com/training/training.aspx?AssetID=RC063800961033 
 

2. Microsoft Online Tutorial – Creating Lists, using bullets, numbers, and other 
list types 
http://office.microsoft.com/training/Training.aspx?AssetID=RC102161651033&CTT=6&O
rigin=RC102161651033 for 

 
3. Accessibility/Universal Design Toolkit from Accessible Technology Initiative 

(ATI)  website: http://www.csun.edu/accessibility/aticoordinators/access_ud_toolkit.html 
has additional resources.  Each collage has an ATI coordinator to assist you.  You will 
find a listing on http://www.csun.edu/accessibility/aticoordinators.html. 

  

 

 

This manual is an introduction to accessibility coding in Microsoft Word 2007 and Adobe 
Acrobat 8.0.  Any further questions can be answered by consulting Microsoft Office and Adobe 
Help documentation.  

http://office.microsoft.com/training/training.aspx?AssetID=RC063800961033�
http://office.microsoft.com/training/Training.aspx?AssetID=RC102161651033&CTT=6&Origin=RC102161651033�
http://office.microsoft.com/training/Training.aspx?AssetID=RC102161651033&CTT=6&Origin=RC102161651033�
http://www.csun.edu/accessibility/aticoordinators/access_ud_toolkit.html�
http://www.csun.edu/accessibility/aticoordinators.html�
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